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RMS Office Introduction

Welcome to the Mid-Tech Roadway Management System (RMS) Office Suite. The Mid-Tech RMS 
Office product is a comprehensive software package designed specifically for the support of road-
way spraying applications, using the Mid-Tech Legacy 6000 console. The Legacy 6000 console 
must be loaded with RMS Application Rate Management software. 

With RMS Office, roadway applications are more effectively managed. RMS Office allows the 
building of specific profiles (small data bases) for company, personnel, contracting agencies, 
chemicals, and chemical mixes, as well as vehicle and spray configurations. The Export function 
allows this profile information to be transferred to the Legacy 6000 console via a PC card.

When installed on the Legacy 6000, profile information is combined with a GPS based map, cre-
ated during the actual application process, to produce final roadway application data. The data 
from a completed roadway application session is then transferred back to RMS Office where Appli-
cation reports are generated. Maps included with the reports show all spray activity, including 
boom and channel activity, for an entire roadway spraying session.

This User Guide is broken into the following components that make up the RMS Office Suite:

• Chapter 2: Profiles - Building small data bases for Personnel, Agencies, Vehicles, Chemicals, 
and Spray Configurations.

• Chapter 3: Tools - Several useful utilities. Report Generator allows the building of a final report 
for a spraying session.

• Chapter 4: Map Manager - A data viewing and management tool. Although part of Tools, Map 
Manager needs a chapter to itself.

Additional RMS Features Include

Base Map Images

You can now view Geo-Tif (DRG) image files in the background of most RMS real-time mapping 
applications, such as RMS Mapper and RMS Record Spray Session, as well as RMS Map Man-
ager.

Names Database Manager

This is a new utility application, found under the RMS Launcher-Tools menu. The Names Manager 
allows the construction of a list of commonly used attribute names. You can access any names 
database from any of the real-time mapping applications.

Export Application

This utility allows the transfer of profiles from RMS-Office to a Legacy 6000 console. This helps 
keep the Legacy 6000 profiles up to date and in-sync with the office.
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Starting RMS Office

To start RMS Office, double click on the RMS Office icon, located on the desktop of your 
computer (The installation process automatically puts the RMS Office icon on the desk-
top of your computer.)

RMS Office is divided into three menu pages: the Profiles menu, the System menu, and the Tools 
menu. You can access these menu pages using the menu tabs located at the bottom of the 
Launcher window. The number on each tab indicates the function key that you can press to access 
that page. Figure 1-1 shows RMS-Office Profiles. 

Figure 1-1: Mid-Tech RMS Program Launcher
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Profiles Menu Page

The Profiles Menu Page (Figure 1-2) contains the Agency, Personnel, Vehicle, Chemical, Chemi-
cal Mix, and Spray Configuration profiles. These profiles are small data bases that must be popu-
lated prior to running the RMS Record Spray Session application. For more information on 
Profiles, see Chapter 2 - RMS Profiles of this user guide.

Figure 1-2: RMS Office Profiles Menu Page
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Tools Menu Page

The Tools Menu Page (Figure 1-3) contains utility programs, such as Report Wizard, Export, Map 
Manager, and Name Manager database builder. This user’s guide will cover each Tools program in 
more detail later (see Chapter 3 - RMS Tools of this user’s guide).

Figure 1-3: RMS Office Tools Menu
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Tool Description

Export The Export tool allows Profiles to be transferred to a Legacy 
6000. You cannot copy Profiles and Names files directly to a Legacy 
6000 console. You must use the Export program.

Map Manager This is a data editing, viewing, and printing application. This version of 
Map Manager now includes Layering and a full suite of drawing tools.

Name Manager You can build Name databases for specific mapping themes, such as 
weed mapping and spray route campaigns. A names database spe-
cific to weed mapping, contains the names of the most commonly 
encountered weeds for your region. Instead of typing in the name of a 
weed each time it is mapped, the name can easily be selected from 
the existing weeds database. For more details, see Chapter 4 - RMS 
Map Manager.

Report Wizard This application allows a detailed report to be generated from road-
side applications. It incorporates the Profiles information, and any 
information entered by the operator during the actual roadside appli-
cation.

Table 1-1: RMS Office Tools Description
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RMS Office System Menu Page

The System Menu Page (Figure 1-4) contains the System Setup application. The units of measure 
for the RMS-Office software are set here. To start System Setup, highlight System Setup in the 
System launcher page and press enter.

Figure 1-4: RMS Office System Menu Page



1-8 Chapter 1 - RMS Office Introduction
RMS Office System Menu Page

RMS Office
Software Version 3.10  

System Setup-Main

You must run System Setup (Figure 1-5) the first time Mid-Tech RMS Office software is started. It 
should be necessary to run System Setup once unless changes are made to the system units. 
Switching from English units to Metric is an example of when you would run System Setup again.

Unit of Measure Menu Field

This menu item allows the selection of the measurement unit that the mapping software displays. 
There are two choices: ENGLISH and METRIC. Selecting ENGLISH units displays all distances in 
feet and miles, areas in square feet and acres, vehicle speed in miles per hour, liquid volume in 
ounces and gallons, and weight in Pounds. Selecting METRIC units displays distances in meters 
and kilometers, areas in square meters and hectares, vehicle speed in Kilometers per hour, liquid 
volume in liters, and weight in Kilograms (see Table 1-2).

Figure 1-5: The System Setup Page
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Unit Name Description

English Selecting English sets Distance to Feet (F) and Miles (Mi), Area to Ft.-
squared and Ac, Speed to Mile per Hour (m.p.h.), liquid volume to 
ounces (oz) and gallons (gal), and Weights to Pounds (lb).

Metric Selecting Metric sets Distance to Meters (M) and Kilometers (Km), 
Area to Square Meters and Hectares (H), Speed to Km per Hour, liq-
uid volume to litres, and Weights to Kilograms (Kg).

Table 1-2: Unit of Measure Description
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RMS Folders

The following folders are in the RMS folder of the computer that RMS Office is installed on. The 
default location is the root directory of the hard drive unless reassigned during installation.

The Bin Folder

The RMS bin folder contains all of RMS Office program executables. All files, located in this folder 
at the time of installation, must remain in this folder for the RMS Office applications to work prop-
erly. You can place shortcuts, to the application executables in this folder, on the desktop for easy 
access. For example, to place a shortcut to Map Manager on the desk top, look for the Map Man-
ager executable in this folder.

The Base Maps Folder

All of the base map images, to be displayed in the background of the mapping software applica-
tions, are stored in the Basemaps folder of the RMS folder. This version of RMS allows the display-
ing of a Digital Raster Graphics (DRG) image file, in the form of a Tagged Image File Format (TIF) 
also known as a Geo-Tif. This image data is useful as a backdrop onto which other real-time col-
lected data, such as spray routes, no spray zones, and weed patch locations, can be overlaid.

The Names Database Folder

A feature of RMS Office is the ability to construct names databases. You can access a names 
database from any of the RMS real-time mapping applications that require the input of an attribute 
name for a graphical object, such as a point. You can build Name databases for specific mapping 
themes, such as weed mapping and spray route campaigns. A names database, specific to weed 
mapping, would contain the names of the most commonly encountered weeds for the region. 
Instead of typing in the name of a weed each time it is mapped, you can easily select it from the 
existing weeds database. All names databases created are stored in the Names folder. For more 
information on the Name Manager application, see Chapter 3 of this User Guide.

The Profiles Folder

All Profiles are stored here.

The Data Folder

This is a suggested location for storing Roadside data. Our application allows other folder loca-
tions to be browsed.
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About RMS Profiles

Profiles are small databases, created to store typical information pertaining to Chemicals, Person-
nel, Vehicles, and Agencies, used during a roadside application session. Use this profile informa-
tion to generate spray application reports, when a spray session is completed. There are six 
different profiles needed to successfully start a roadside application session, using the Mid-Tech 
RMS Application Rate Management (ARM) software. 

Create all profiles in RMS-Office and transfer them, via the PC card, to the Legacy 6000 
console running RMS-EXT software. Transfer the profiles using the RMS-Office Export 
program (see Chapter 3 - RMS Tools).

Access each of these profiles through the RMS Launcher Profiles page. Create, edit, and delete 
any profile. You only need to create a profile once. After that, select a specific profile required to 
build the spray session setup.

Profile Description

Agency contains information about the agency contracting the spraying 
services.

Chemical contains a list of chemicals commonly used in a spraying appli-
cation.

Chemical Mixture contains a list of chemical tank mixes commonly used in a 
spraying application.

Personnel contains information about vehicle drivers and operators.

Spray Configuration allows the setup of boom, tank, and channel configurations for 
vehicles.

Vehicle allows the configuring, of a particular vehicle, with specific 
spray configurations.

Table 2-1: RMS Profiles
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Figure 2-1: RMS Office Profile Menu Page
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The Agency Profile

The Agency Profile contains information about the agency or organization that is con-
tracting the services. To create or edit an Agency profile, select the Agency Profile 
located in the RMS Launcher Profiles page. The first page displayed is a list of agen-
cies currently entered into the Agency Profile database (see Figure 2-2). If you have 
not entered any agencies the profile yet, this is empty. To create a new agency, press 

the New button. To edit an existing agency, select the desired agency from the list of agencies and 
press Enter, or double click on the agency name using the mouse. To delete an existing agency, 
highlight the desired agency name, and press the Delete Button. 

When finished creating a new agency, press the OK button to save and add this new agency into 
the agency profile list. If you decide not to add the agency being created, simply press the Cancel 
button to return to the Agency Profile list.

To Exit the Agency Profile, press the Exit Button. The program returns to the RMS Launcher Pro-
files page.

All profiles are created in RMS-Office and then transferred, via the PC card, to the Leg-
acy 6000 console running RMS-EXT software. Transfer Profiles using the RMS Office 
Export program (see Chapter 3 - RMS Tools).

Figure 2-2: Agency Profiles



RMS Office
Software Version 3.10 

Chapter 2 - RMS Profiles       2-5 
The Agency Profile

Creating a New Agency Profile

There are three agency profile pages that make up a complete agency profile: the Main Page, the 
Contact Page, and the Admin Page. See Table 2-2 for more details about each page.

The Main Page (see Figure 2-3) contains the name and address information specific to the con-
tracting agency. The Contact Page contains information about the contact person at the agency. 
Press the Contact Tab to access this page. The Admin Page contains the Active and Hidden selec-
tions. 

Figure 2-3: The Main Agency Page
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Profile Field Description

The Main Page

Agency ID A unique identification used to identify a specific agency.

Agency Name The name of the agency

Division The agency division

Street The agency street address.

City The city where the agency is located.

County/MD The county where the agency is located.

State/Province The state or province where the agency is located.

Country The country where the agency is located.

Zip / Postal Code The zip or postal code for the agency.

Contact Page

Contact Name The name of person at agency who can be contacted.

Phone Number The phone number of the contact person

Admin Page

Record Status Setting a profile to Active makes that profile viewable and selectable 
when transferred to the Legacy 6000. Setting a profile to Hidden pre-
vents it’s being selectable or viewable to the operator, when it is trans-
ferred to a Legacy 6000. This allows a manager to limit the number of 
in-field selections an operator must make while in the field.

Table 2-2: Agency Profile Description



RMS Office
Software Version 3.10 

Chapter 2 - RMS Profiles       2-7 
The Chemical Profile

The Chemical Profile

The Chemical Profile is a database containing the name and manufacturer of all the 
chemicals used in a roadside spraying application. To access the Chemical Profile 
page, select the Chemical Profile located in the RMS Launcher Profiles page. The 
first page displayed is a list of chemicals currently entered into the Chemical Profile 
database (see Figure 2-4). If you have not entered any chemicals into the profile yet, 

this page is empty. To enter a new chemical, press the New button. To edit an existing chemical, 
select the desired chemical from the list of chemicals, and press Enter or double click on the 
chemical name, using the mouse. To delete an existing chemical, highlight the desired chemical 
name and press the Delete Button. 

When finished entering a new chemical, press the OK button to save and add this new chemical 
into the Chemical Profile list. If you decide not to add the chemical, simply press the Cancel button 
to return to the Chemical Profile list.

To Exit the Chemical Profile, press the Exit Button. The program returns to the RMS Launcher Pro-
files page.

Create all profiles in RMS Office and transfer, via a PC card, to the Legacy 6000 console 
running RMS-EXT software. Transfer profiles using the RMS-Office Export program (see 
Chapter 3 - RMS Tools).

Figure 2-4: The Chemical Profiles Page
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Creating a New Chemical Profile

To enter a new chemical, press the New button, which brings up the main chemical editing page 
(see Figure 2-5). The Main page, denoted by the Main tab located at the bottom of the page, con-
tains the following menu fields (see Table 2-3). The Admin page contains the Active and Hidden 
selections.

Figure 2-5: The Main Chemical Editing Page
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Profile Field Description

The Main Page

Chemical Name The name of the chemical being entered into the Chemical profile.

Manufacturer The name of the chemical manufacturer.

EPA Reg# The chemical EPA registration number.

Com Code The chemical commodity code.

Type The type of chemical being entered. When entering this menu 
item, a pick dialog box appears, with a list of chemical types: 
Dry, Liquid or Dry Flowable.

Measurement Unit The unit of measure associated with the chemical being 
entered. When this menu item is selected, a Unit of Measure 
dialog appears, containing a list of units to choose from.

Maximum Mix Ratio The maximum concentration of dry material in a single gallon of liquid 
carrier. This menu field is active only if the chemical type is Dry or Dry 
Flowable.

Displacement The amount of liquid displaced by a unit of dry material in a 
single gallon of carrier. This menu field is active only if the 
chemical type is Dry or Dry Flowable. A typical displacement 
unit would be liquid ounces.

Admin Page

Record Status Setting a profile to Active makes that profile viewable and selectable, 
when transferred to the Legacy 6000. Setting a profile to Hidden pre-
vents it’s being selected or viewed by the operator, when it is trans-
ferred to a Legacy 6000. This allows a manager to limit the number of 
in-field selections an operator must make while in the field.

Table 2-3: Chemical Profile Description
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The Chemical Mixture Profile

The Chemical Mixture Profile contains specific chemical tank mixtures created. Enter 
the Chemicals, used in this profile, into the Chemical Profile prior to creating a mixture 
profile. To access the Chemical Mixture Profile page, select the Chemical Mixture 
Profile, located in the RMS Launcher Profiles page. The first page displayed is a list of 
chemical mixes currently entered into the Chemical Mixture Profile database (see 

Figure 2-6). If you have not entered any chemical mixes into the profile yet, this page is empty. To 
enter a new mixture, press the New button. To edit an existing chemical mixture, select the desired 
mixture from the list of mixes, and press Enter or double click on the mixture name, using the 
mouse. To delete an existing mixture, highlight the desired mixture name and press the Delete 
Button. 

When finished entering a new chemical mixture, press the OK button to save and add this new mix 
into the Chemical Mixture Profile list. If you decide not to add the mixture, simply press the Cancel 
button to return to the Chemical Mixture Profile list.

To Exit the Chemical Mixture Profile, press the Exit Button. The program returns to the RMS 
Launcher Profiles page.

Create all profiles in RMS Office and transfer them, via the PC card, to the Legacy 6000 
console running RMS-EXT software. Transfer the Profiles using the RMS-Office Export 
program (see Chapter 3 - RMS Tools).

Figure 2-6: The Chemical Mixture Profile Page
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Creating a New Chemical Mixture Profile

To create a new chemical mixture, use the RMS Chemical Calculator. The Chemical Calculator is 
accessed through the Mixture Name menu field, located on the Chemical Mixture Main menu page 
(see The Main Page on page 2-19). It is best to understand the Chemical Calculator prior to 
reviewing any of the Chemical Mixture profile pages.

The RMS Chemical Calculator

The RMS Chemical Calculator is a powerful chemical mix utility program, used to combine up to 
three chemicals, plus a carrier, into a single mixture. The chemicals in the mixture must appear in 
the Chemical Profile (see The Chemical Profile on page 2-7) prior to adding them into a mixture. 
The Chemical Calculator accesses the Chemical Profile for information, such as chemical type 
and unit, for each chemical added to the mixture. The Chemical Calculator requires an application 
rate for each chemical in the mixture, as well as the tank volume or amount of mixture to be made. 
When the chemicals are added to the mix, the Chemical Calculator determines the amount of each 
chemical and carrier required for the mixture tank volume.

Krovar plus Oust Mixture Example

To demonstrate the Chemical Calculator, consider a mixture of Krovar (Dry Flowable), mixed with 
Oust, with water as a carrier. The application rate for the Krovar is 8 Pounds/Acre and the applica-
tion rate for the Oust is 3 Oz./Acre. Both chemicals have been entered into the Chemical Profile 
and therefore can be selected directly from the Chemical Calculator. The tank volume for the mix-
ture is 50 Gallons.

Starting Up the Chemical Calculator

To enter the Chemical Calculator, select the Mixture Name menu field, located on the Main menu 
page. Press enter, or double click with the mouse on the Mixture Name menu field, to activate the 
Chemical Calculator dialog (see Figure 2-7).

Entering Krovar DF as the First Chemical

To enter Krovar as the first chemical, place the cursor in the Chemical 1 menu field and press 
enter. This activates the Select Chemical 1 dialog (see Figure 2-8). Move through the list of chem-
icals, select Krovar, and press enter. To move through the chemical list rapidly, type in the first let-
ter of the chemical to be entered. This causes the program to jump down the chemical list to the 
first chemical name beginning with the letter entered. All of the chemicals listed in this dialog were 
entered using the Chemical Profile.

Entering the Krovar Application Rate

Select the chemical and enter the chemical application rate. Tab the cursor over to the Chemical 1 
Application Rate menu field and press enter. This activates the Chemical 1 Rate dialog box (see 
Figure 2-9). In the example, the application rate for Krovar is 8 Pounds/Acre. Notice that the unit of 
pounds is already set in the Rate dialog box. The rate unit for Krovar is contained in the Chemical 
Profile and retrieved by the calculator. This eliminates the need to remember or look up the 
required rate unit for each chemical. Enter 8 Pounds/Acre in the dialog and press enter. Krovar is 
now entered as the first chemical in the mixture. Now enter the second chemical, Oust.



2-12 Chapter 2 - RMS Profiles
The Chemical Mixture Profile

RMS Office
Software Version 3.10  

Figure 2-7: The Chemical Calculator Dialog

Figure 2-8: The Select Chemical 1 (Krovar DF) Dialog
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Figure 2-9: The Select Chemical Rate Dialog
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Entering Oust as the Second Chemical

To enter Oust as the second chemical, place the cursor in the Chemical 2 menu field and press 
enter. This activates the Select Chemical 2 dialog. Move through the list of chemicals, select Oust, 
and press enter. To move through the chemical list rapidly, type in the first letter of the desired 
chemical. The program jumps down the chemical list to the first chemical name beginning with the 
letter entered. All of the chemicals listed in this dialog are contained in the Chemical Profile.

Entering the Oust Application Rate

After selecting the chemical, enter the chemical application rate. Tab the cursor to the Chemical 2 
Application Rate menu field and press enter. This activates the Chemical 2 Rate dialog box (see 
Figure 2-11). In the example, the application rate for Oust is 3 Oz./Acre. Notice that the unit of 
Ounces is already set in the Rate dialog box. The rate unit for Oust is contained in the Chemical 
Profile and retrieved by the calculator. This eliminates the need to remember or look up the 
required rate unit for each chemical. Enter 3 Oz./Acre in the dialog and press enter. Oust is now 
entered as the second chemical in the mixture (see Figure 2-12). 

Figure 2-10: Krovar DF Entered into Calculator
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Figure 2-11: The Chemical Rate Dialog for Oust

Figure 2-12: Oust Entered into the Chemical Calculator
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Entering the Total Mix Volume

When both chemicals are entered into the calculator, enter the total mix volume. Place the cursor 
in the Total Volume menu field and press enter. This activates the Total Mix Volume dialog box 
(see Figure 2-13). In this example, the total mix volume entered is 50 gallons (see Figure 2-14).

Figure 2-13: The Total Mix Volume Dialog
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Calculating the Mixture

Now that you have entered the two chemicals, the chemical application rates, and the total mix 
volume, the next step is to calculate the mixture. To calculate the mixture, press the Calculate but-
ton located at the lower left corner of the Chemical Calculator dialog. The Chemical Calculator cal-
culates the following values:

• Mid-Tech Console Rate.

• Quantity of required material for chemical 1.

• Quantity of required material for chemical 2.

• Quantity of required carrier.

• Application rate of the carrier (calculated from the Maximum Mix Ratio entered for the Dry 
material in Chemical Profile).

• Area that this mixture can cover based on chemical application rates.

See Figure 2-15 for the calculated results of this example. When satisfied with the calculation, 
press the OK button to return to the Chemical Mixture Main menu page (see Figure 2-16). Notice 
that, on the Main page, all of the appropriate menu fields have been automatically filled in, includ-
ing the mixture name.

If you know the average boom width and average speed of the vehicle during the application pro-
cess, enter these values into the Chemical Calculator and calculate the total distance you can 
cover as well as the Average Pump Flow Rate.

Figure 2-14: Total Mix Volume Entered
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Figure 2-15: Mix Calculation Results

Figure 2-16: The Main Page after Mix Calculation
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The Main Page

Pressing the New button, to enter a new chemical mixture, brings up the main mixture editing page 
(see Figure 2-16). The Main page, denoted by the Main tab located at the bottom of the page, con-
tains the following menu fields.

Profile Field Description

The Main Page

Mixture Name The name of the mixture being created. When you enter this menu 
field, the RMS Chemical Calculator appears (see Figure 2-7). Filling 
in this menu field is optional. When you complete the calculation for a 
mixture, the system fills in the Mixture Name menu field automatically.

Chemical #1 The name of the first chemical in the mix.

Concentration The concentration of chemical 1 used in the mixture. The Chemical 
Calculator fills in this menu field automatically.

Target Rate The target rate entered into the Chemical Calculator for chemical 1. 
The Chemical Calculator fills in this menu field automatically.

Chemical #2 The name of the second chemical used in the mixture. The Chemical 
Calculator fills in this menu field automatically.

Concentration The concentration of chemical 2 used in the mixture. The Chemical 
Calculator fills in this menu field automatically.

Target Rate The target rate entered into the Chemical Calculator for chemical 2. 
The Chemical Calculator fills in this menu field automatically.

Chemical #3 The name of the third chemical used in the mixture. The Chemical 
Calculator fills in this menu field automatically.

Concentration The concentration of chemical 3 used in the mixture. The Chemical 
Calculator fills in this menu field automatically.

Target Rate The target rate entered into the Chemical Calculator for chemical 3. 
The Chemical Calculator fills in this menu field automatically.

Admin Page

Record Status Setting a profile to Active makes that profile viewable and selectable 
when transferred to the Legacy 6000. Setting a profile to Hidden pre-
vents it’s being selected or viewed by the operator, when it is trans-
ferred to a Legacy 6000. This allows a manager to limit the number of 
in-field selections an operator must make while in the field.

Table 2-4: Chemical Mix Profile Description
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The Personnel Profile

The Personnel Profile is a database containing a record of the employees associated 
with a spraying application. Typically a personnel profile is created for vehicle drivers 
and sprayer operators. To access the Personnel Profile page, select the Personnel 
Profile located in the RMS Launcher Profiles page. The first page displayed is a list of 
profiles, currently entered into the Personnel Profile database (see Figure 2-17). If 

you have not entered any profiles yet, this page is empty. To enter a new profile press the New but-
ton. To edit an existing profile, select the desired profile from the list of profiles, and press Enter, or 
double click on the profile name using the mouse. To delete an existing profile, highlight the 
desired profile name and press the Delete Button. 

When finished entering a new profile, press the OK button to save and add this new profile into the 
Personnel Profile list. If you decide not to add the profile, simply press the Cancel button to return 
to the Personnel Profile list.

To Exit the Personnel Profile, press the Exit Button. This returns the program to the RMS Launcher 
Profiles page.

Create all profiles in RMS Office and transfer, via a PC card, to the Legacy 6000 console 
running RMS-EXT software. Transfer the profiles using the RMS-Office Export program 
(see Chapter 3 - RMS Tools).

Figure 2-17: The Personnel Profile Page
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Creating a New Personnel Profile

Pressing the New button, to create a new Personnel Profile, brings up the Main Personnel Profile 
editing page (see Figure 2-18). The Admin page contains the Active and HIdden selections. 

Table 2-5 contains a description of the Personnel profile fields. When all fields are filled in, press 
OK to save the profile.

Figure 2-18: The Main Personnel Profile Page
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Profile Field Description

The Main Page

Last Name The last name of the employee.

First Name The first name of the employee.

Employee ID The employee’s identification number.

SSN (SIN) The employee’s Social Security Number or Social Insurance Number.

Pesticide Lic # The employee’s pesticide license number.

Expiration The pesticide license expiration date.

Driver’s Lic # The employee’s drivers license number.

Supervisor The employee’s supervisor.

Phone A telephone number where the supervisor or employee can be con-
tacted.

Admin Page

Record Status Setting a profile to Active makes that profile viewable and selectable 
when transferred to the Legacy 6000. Setting a profile to Hidden pre-
vents it’s being selected or viewed by the operator, when it is trans-
ferred to a Legacy 6000. This allows a manager to limit the number of 
in-field selections an operator must make while in the field.

Table 2-5: Personnel Profile Description
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The Vehicle Profile

The Vehicle Profile contains information associated with the vehicle delivery system: 
spray controller, tank volumes, and tank to channel assignment. Create a profile for 
each vehicle used in a roadside spraying application. To access the Vehicle Profile 
page, select the Vehicle Profile located in the RMS Launcher Profiles page. The first 
page displayed is a list of profiles currently entered into the Vehicle database (see 

Figure 2-19). If you have not entered any profiles yet, this page is empty. To enter a new profile, 
press the New button. To edit an existing profile select the desired profile, from the list of profiles, 
and press Enter, or double click on the profile name using the mouse. To delete an existing profile, 
highlight the desired profile name and press the Delete Button. 

When finished entering a new profile, press the OK button to save and add this new profile into the 
Vehicle list. If you decide not to add the profile, simply press the Cancel button to return to the 
Vehicle Profile list.

To Exit the Vehicle Profile, press the Exit Button. This returns the program to the RMS Launcher 
Profiles page.

Create all profiles in RMS-Office and transfer them, via a PC card, to the Legacy 6000 
console running RMS-EXT software. Transfer profiles using the RMS-Office Export pro-
gram (see Chapter 3 - RMS Tools).

Figure 2-19: The Vehicle Profile List
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Creating a New Vehicle Profile

Press the New button to create a new Vehicle Profile. This brings up the main profile editing page 
(see Figure 2-20). There are three additional page tabs: Tanks, Channels, and Admin. The menu 
items found on each of these menu pages must be filled in.

The Main page contains vehicle identification information. The tank unit and volumes are entered 
in the Tanks page. The Tank to Pump association is made in the Channels page. The Admin page 
contains the Active and HIdden selections. Table 2-6 contains a description of the Vehicle profile 
fields. When you complete all fields, press OK to save the profile.

Figure 2-20: The Main Page
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Profile Field Description

The Main Page

Vehicle ID A unique identifier for the vehicle being entered.

Controller Selecting this controller menu item brings up a Controller dialog box 
(see Figure 2-21). This dialog contains a list of Mid-Tech controller 
drivers that are compatible with the RMS software. Select the control-
ler driver that matches the rate controller installed on the vehicle.

The Tanks Page

Volume Unit Enter the unit of volume used in this profile. Selecting this menu field 
activates a Volume Units dialog. Pick the volume unit used from this 
dialog.

Carrier Enter the volume of the Carrier tank.

Tank #1 - #8 The menu fields for Tanks 1 though 8 are identical. Enter the volume 
for each tank installed on the vehicle. If the vehicle does not have 8 
tanks, leave any non-existent tank menu fields blank.

The Channels Page

Carrier This is the pump associated with the carrier tank. Typically, select the 
carrier tank from the Carrier Assignment dialog.

Pumps #1 - #9 Selecting any of these Pump menu fields activates a Pump dialog box 
(see Figure 2-23). From the dialog box, select the desired tank for the 
pump. Pumps and tanks can be mixed and matched (e.g. Pump 2 can 
have Tank 3 assigned to it). Do not assign a tank to more than one 
pump.

Admin Page

Record Status Setting a profile to Active makes that profile viewable and selectable 
when transferred to the Legacy 6000. Setting a profile to Hidden pre-
vents it’s being selected or viewed by the operator, when it is trans-
ferred to a Legacy 6000. This allows a manager to limit the number of 
in-field selections an operator has to make while in the field.

Table 2-6: Vehicle Profile Description
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Figure 2-21: The Rate Controller Dialog

Figure 2-22: The Tanks Page



RMS Office
Software Version 3.10 

Chapter 2 - RMS Profiles       2-27 
The Vehicle Profile

Figure 2-23: The Pump Dialog Box

Figure 2-24: The Channels Page
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The Spray Configuration Profile

The Spray Configuration Profile allows the creation of different spray boom configura-
tions for the fleet. When the actual spray application session is started, select the 
specific spray boom configuration for your vehicle. 

To access the Spray Configuration Profile page, select the Spray Configuration Pro-
file, located in the RMS Launcher Profiles page. The first page is a list of profiles currently entered 
into the Spray Configuration database (see Figure 2-25). If you have not entered any profiles yet, 
this page is empty. To enter a new profile, press the New button. To edit an existing profile select 
the desired profile, and press Enter or double click on the profile name using the mouse. To delete 
an existing profile, highlight the desired profile name and press the Delete Button. 

When finished entering a new profile, press the OK button to save and add this new profile into the 
Spray Configuration list. If you decide not to add the profile to the profile database, simply press 
the Cancel button to return to the Spray Configuration Profile list.

To Exit the Spray Configuration Profile, press the Exit Button. This returns the program to the RMS 
Launcher Profiles page.

Create all profiles in RMS-Office and transfer it, via the PC card, to the Legacy 6000 con-
sole running RMS-EXT software. Transfer profiles using the RMS-Office Export program 
(see Chapter 3 - RMS Tools).

Figure 2-25: The Spray Configuration Profile Page
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Creating a New Spray Configuration Profile

Press the New button to create a new Spray Configuration Profile. This brings up the main profile 
editing page (see Figure 2-26). Notice that there are three additional page tabs; 3 - 6, 7 - 10 and 
Admin. The Admin page contains the Active and Hidden selections. 

It is not necessary to fill in menu items found on each of these menu pages (seeTable 2-7).

Figure 2-26: Spray Config Main Page
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RMS does not proceed with the spraying unless the boom widths, programmed into the 
selected Spray Configuration, are the same as those programmed into the TASC rate 
controller.

Profile Field Description

The Main Page

Spray Config Name Enter the name of the new spray configuration. Try to use a name that 
best describes the configuration.

Hand Gun Selecting this menu field activates the Hand Gun dialog box. If using a 
hand gun, select Yes. If not using a hand gun, select No.

Boom 1 Width Selecting this menu field activates the Boom Width dialog. Enter the 
width of Boom 1 in inches. When entered, the boom section is drawn 
in the vehicle diagram located at the bottom of the page.

Offset Selecting this menu field activates the Boom Offset dialog. Enter the 
offset distance, from the center line of the vehicle to the closest point 
in the boom you are programming. Select which direction (Left or 
Right) from center line of the vehicle to place the boom. If the boom is 
to be centered on the vehicles center line, select CENTER for the off-
set direction. Always use the vehicle graphic at the bottom of the page 
to ensure that the created the boom section is in the proper location.

Boom 2 Width See Boom Width description above.

Offset See Offset description above.

The 3-6 Page

Boom 3 - 6 Width See Boom width description above.

Offsets 3 - 6 See Offset description above.

The 7 - 10 Page

Booms 7 - 10 See Boom width description above.

Offsets 7 - 10 See Offset description above.

Admin Page

Record Status Setting a profile to Active makes that profile viewable and selectable 
when transferred to the Legacy 6000. Setting a profile to Hidden pre-
vents it’s being selected or viewed by the operator, when it is trans-
ferred to a Legacy 6000. This allows a manager to limit the number of 
in-field selections an operator has to make while in the field.

Table 2-7: Spray Config Profile Description
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RMS Tools Introduction

This chapter covers several utility applications that can make your life a little bit easier. Currently 
RMS - Tools consists of four applications: Export, Map Manager, Name Manager, and Report Wiz-
ard. All Tools are accessed from the RMS Office Tools Menu (see Figure 3-1).

 

Figure 3-1: RMS Tools Launcher

Tool Description

Export The Export tool allows the transfer of Profiles and Names files to a 
Legacy 6000 console.

Map Manager The Map Manager Tool is covered in Chapter 4 of this User’s Guide.

Name Manager Name Manager allows you to build attribute databases, used for nam-
ing objects during the real-time mapping process.

Report Wizard The Report Wizard Tool allows you to generate a detailed report of a 
roadside spray application or session.

Table 3-1: RMS Tools Description
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Export

Use the Export tool (Figure 3-2) to transfer Profiles and Name files between RMS 
Office and a Legacy 6000. As your Profile information changes over time, you must 
keep your Legacy 6000 up to date. Information on Profiles are found in Chapter 2 of 
this User’s Guide. For more information on Names files, see Name Manager on page 
3-5.

You cannot directly copy the Profiles and Names files directly to the PC card. You must 
use the Export tool to compress and reformat them, to run in the Windows CE environ-
ment. You can directly copy RMS data files such as (.RCD), (.GMF), (.EVP) and (.TIF) 
between RMS Office (your PC) and a Legacy 6000 console.

Export Steps:

• When you have finished making changes to any Profiles or Names files, insert a PC card into 
your PC card drive and run the Export tool.

• Select the PC card drive by using the Browse button, (Figure 3-3).

• Select the profiles that you want to export to the PC card, by clicking in the select box to the 
left of the Profile name.

• Select the Names files that you want to export to the PC card, by clicking in the select box to 
the left of the Name Files name.

• Press the Export button to begin file transfer to the PC card. An IMPORT folder is created on 
the PC card. Profiles and Names files a exported to sub folders of the IMPORT folder. Do not 
move or modify these files on the PC card. 

• Safely remove the PC card from the drive.

• Insert the PC card into the Legacy 6000 that you want to update. Turn the console on.

• The Legacy 6000 will detect new Profile and Names files on the PC card and ask if you would 
like to import these new files. Use the Arrow keys to make the appropriate selection.

• The import process performs a file comparison with all modified files. Files are updated with 
new information and not over-written. The import process moves files from the PC card to the 
console flash memory. You cannot directly copy these files to the appropriate location. The 
import process must be used.
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Figure 3-2: The Export Dialog

Figure 3-3: The Browse Dialog
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Name Manager

The Name Manager application (Figure 3-4) allows you to construct a database of 
commonly used attribute names. These databases can be accessed from any of the 
Mid-Tech RMS real-time applications, such as RMS - Mapper, RMS - EXT, or RMS - 
CAN. Using a names database helps you to efficiently store, select, and name map-

ping objects, while out in the field. Database file names can be named for a specific task or theme, 
such as Road Signs. Figure 3-4 shows the Name Manager, with the Weeds database highlighted. 
The attribute names, contained in the Weeds database, are commonly used during potential spray 
route weed mapping campaigns with RMS - Mapper. Utility inventory is another mapping task that 
requires unique names and naming schemes. These names and schemes are stored in a names 
database. Roadside mapping or route scouting could have several associated name databases.

You must use the Export tool to export Names files to the Legacy 6000 console (see 
Export on page 3-3).

To start Name Manager, select “Name Manager” in the RMS Program Launcher Tools Menu (Fig-
ure 3-1).

Name Database File Format

Name database files are ASCII text files, (.TXT). You can create these files in several different edi-
tors, spread sheets, and word processors. A single column of names, typed into an Excel spread 
sheet, can be copied to the Windows clipboard and pasted into any names database file. This 
makes it easy to move existing attribute information into the names database file format. You may 
find it easier to simply type name attributes, one name per line, into a word processor or editor, 
and save that file as a text file with the extension (.TXT).

All name databases, that you want to export to a Legacy 6000 console, must be kept in the 
C:\RMS\NAMES directory. Do not store name databases in any other folder. The program auto-
matically alphabetizes names entered into a database. The following few lines represent a typical 
names database, used in roadside mapping tasks.
Channel 1
Channel 2
Channel 3
Intersection
Mailbox.
Mile Marker
Mustard
No Spray 
Spray On
Spray Off
Thistle
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Figure 3-4: The Names Database Dialog

Directory path to your 
name databases.

 To create a new name data-
base, file click here.

To rename a name data-
base file, click here.

To delete an existing name 
database file, click here.

All existing name database 
files, for the current direc-
tory, are displayed here.

To add a new name to the 
current name database, 
click here.

To rename a name in the 
database file, click here.

To delete a name in the cur-
rent database, click here.

All attributes for roadside 
database are listed here.

Using the Cut, Copy, and Paste buttons, you can 
move names form one database file to another.

To Exit the Name Manager, click on 
the Close button.
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Report Wizard

Report Wizard compiles all information, map data, and profiles, associated with a spray-
ing session, into an organized spray session report. This final report can contain all pro-
files associated with the spray session, as well as any maps created during the spray 
session. You can customize the final report by adding different map views, and also by 

adding your company logo and address to the front page of the report. To start Report Wizard, 
select “Report Wizard” from the RMS Program Launcher Tools Menu (Figure 3-5).

Figure 3-5: RMS - Report Wizard
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Generating a Session Report with Report Wizard

Generating a final spray session report is easy using Report Wizard. You must have a completed 
spray session, with all associated data, prior to generating a final report. Your data is collected and 
stored on the PC card, under the Job Id folder name for that session. You can either transfer the 
session folders from the PC card to your office computer, or you can generate reports directly from 
the PC card, while it is inserted into the PC card slot, on your office computer. It is recommended 
that you copy the job folders from the PC card to a folder on your Office computer. This provides a 
backup for your data, as well as freeing up space on the PC card. The C:\RMS\data folder is the 
recommended location for your job folders, on the office PC. 

When you have started Report Wizard from the RMS Program Launcher, the first Report Wizard 
dialog appears (Figure 3-6).

Select Spray Session 

The first step is to select the spray session you want to generate a report for. Figure 3-6 shows the 
Report Wizard Session dialog. First browse to the location of your Job or session folders. Data can 
also reside on the PC card. Next select the existing spray session from the list, in the pull down 
menu field. Spray Session 140999-01 is used as the example spray session that we want to gen-
erate a report for. This session is highlighted in Figure 3-6. With the desired session selected, 
press the “next” button in the lower right corner.

Figure 3-6: Report Wizard Session Dialog
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Report Information

The report information dialog allows you to customize your final spray session report. With this dia-
log, you can select the session profile information to include in the report. You can also select the 
units to present the report in. In the 140999-01 example, we are selecting the full report option. 
The full report option includes all profiles associated with the 140999-01 spray session. If you 
select the custom option, small check boxes appear next to each item, listed in the report informa-
tion scroll menu (see Figure 3-8). To select or de-select information, simply click in the check box 
next to the associated menu item. Figure 3-8 shows the Agency/Company information de-
selected.

Figure 3-7: Report Wizard - Report Information Dialog
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When you have selected the proper choices in the Report Information dialog, press the “next” but-
ton, to continue to the next Report Wizard dialog. A status box appears after you press the “next” 
button. Report Wizard is loading the various session and profile information that you selected in 
the Report Generation dialog. This may take a few seconds and you can see, in the status box, 
which profile and session information is being loaded.

Figure 3-8: Customizing Report Information



RMS Office
Software Version 3.10 

Chapter 3 - RMS Tools       3-11 
Report Wizard

Spray Campaign

The Report Wizard Spray Campaign dialog displays the session (.EVP) map (see Figure 3-9). You 
also have the option to display a background map, if one is available. In our example session 
140999-01, there is a background map used during the spray session. Figure 3-10 shows the 
background map selection and completed Spray Campaign dialog, with background map dis-
played. When you complete the Spray Campaign dialog options, press the “next” button to move to 
the next Report Wizard dialog.

Figure 3-9: Report Wizard Spray Campaign Map
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Figure 3-10: Viewing the Background Map
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Spray Swath Map

The Spray Swath Map dialog allows you to select and de-select the various spray swath map data, 
that was collected during your spray session. The spray swath data is contained in the RMS 
(.RCD) file type. There should be a (.RCD) file, and therefore a spray swath map, for each product 
or mixture, including carrier, applied during a spray session. In our example of spray session 
140999-01, there were two products, RoundUp and Karmex, and one mixture, Krovar + Oust, 
applied (see Figure 3-11). There is an additional selection; the session map. This is the event map 
(.EVP) created during the spray session. A separate map is created, in the report, for each spray 
swath map you select in this dialog. To view a spray swath map, prior to selecting or de-selecting, 
simply highlight the map name with the mouse. The map that appears to the left is the one that you 
highlighted. In Figure 3-11, the session map name is highlighted and the map, to the left, is the 
session map. In our example, we are selecting all maps available to us: Session, Water, Roundup, 
Krovar+Oust, and Karmex. This results in five maps in the final report.

You can also select the grid coordinate units, for the back ground grid. The current two choices are 
Latitude and Longitude or UTM.

With the desired spray swath maps selected, press the “next” button, to move to the next Report 
Wizard dialog.

Figure 3-11: Report Wizard Spray Swath Maps
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Post Session Notes

The Post Session Notes dialog allows you to enter any notes that you want appended to end of the 
report. This is a free form edit box, so you can type any information that you want included in the 
final report. In our example,Figure 3-12, the contracting spraying company requires that the per-
son who generates the final report enter their name in the post session notes.

Once you complete this dialog, press the "next" button to move to the next Report Wizard dialog.

Figure 3-12: Report Wizard Post Session Notes Dialog
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Report Banner

The report Banner dialog allows you to add any information, such as your company logo and 
address, to the first page of the final report. In our example we have added the company logo and 
address (see Figure 3-13). If you have your company logo in a Bitmap file format (.BMP), you can 
insert that image into the banner. See “Customizing your Report Banner" below. 

When the Report Banner dialog is complete, press the "next" button to move to the next Report 
Wizard dialog.

Customizing your Report Banner

To customize your report banner, press the “banner” button in the upper right corner (see Figure 3-
13”. This pops up a word processor, like Edit Banner window (see Figure 3-14). This figure shows 
an empty Edit Banner window. This edit window has many features similar to a word processor. To 
add text, just start typing. To insert a logo, place your cursor at the desired logo location, click on 
the “Insert” pull down menu and select picture. This pops up a Windows explorer browse dialog 
(see Figure 3-15). Move to the folder that contains your logo in bitmap form (.BMP). Select the 
desired bitmap file and press the open button in the browser dialog box. Your logo should now 
appear at the cursor position in the Banner Edit window. In our example, we selected the bitmap 
file Roadside Spraying Services.bmp (Figure 3-15), and can now view it in the Banner Edit window 
(Figure 3-16).

Figure 3-13: Report Wizard Report Banner Dialog
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Figure 3-14: Edit Banner Window

Figure 3-15: Selecting Company Logo Bitmap
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When the logo is located where you want it, in the Edit Banner window, you can type in any addi-
tional text, such as company name and address. Use the Paragraph menu, located in the Edit 
Banner window menu bar to, Left, Right, or Center justify your logo and text. In our example (Fig-
ure 3-17), we added the company name and address and Center justified the logo and text.

When you have the logo and text for your customized banner, save it to a file using the File menu 
item Copy to File. Selecting this menu item brings up a prompt asking for a file name for your cus-
tomized logo. If you want your custom banner to be the default banner for all of your reports, select 
the Save Banner menu item from the File pull down menu. To return to the Report Wizard Report 
Banner dialog, select Exit from the File pull down menu.

Figure 3-16: Edit Banner Window with Company Logo

Figure 3-17: Customized Report Banner
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Output Report

After completing the Report Banner dialog, the final Report Wizard dialog is the Output Report dia-
log. From this dialog, you can preview, print, or save the report (Figure 3-18). Previewing the 
report is always a good idea, before printing or saving the report. 

Printing the Report

To print the report, press the Print button in the Output Report dialog. This prints the report to an 
attached printer. Report Wizard only prints reports in Landscape orientation on 8-1/2 by 11 in. 
paper. Do not try to print your report in any other paper orientation.

Saving the Report

To save the report, press the “save” button. A Windows Explorer dialog appears. Using this dialog, 
name the report and select the folder to store the report in. You can only save the report in rich text 
(.RTF) format.

Opening a Finished Report in Other Applications

Because the Report Wizard saves your reports in (.RTF) format, you can open and edit your report 
in several word processors (Microsoft Word, WordPad, NotePad, Adobe PageMaker, WordPer-
fect, Corel, and more) on the market. You may find this a more convenient way to edit or add to 
your finished report.

Figure 3-18: Output Report Dialog
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Sample Report 140999-01

The following nine pages are final report generated for spray session 140999-01. The first three 
pages contain all of the profile information associated with the spray session (see Figure 3-19 
through Figure 3-21).

Page four is the Spray Campaign map (see Figure 3-22). This map, generated as the event record 
(.EVP) during the actual spraying process shows the entire spray route traveled during the spray 
session 140999-01.

Pages five through nine are the individual Spray Swath maps, starting with the entire Session 
Swath map (see Figure 3-23 through Figure 3-27). There is a Spray Swath map for each product 
or mixture plus carrier, applied during the spray session.
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Figure 3-19: Report 140999-01 Page 1



RMS Office
Software Version 3.10 

Chapter 3 - RMS Tools       3-21 
Report Wizard

Figure 3-20: Report 140999-01 Page 2
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Figure 3-21: Report 140999-01 Page 3
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Figure 3-22: Report 140999-01 Page 4
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Figure 3-23: Report 140999-01 Page 5
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Figure 3-24: Report 140999-01 Page 6
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Figure 3-25: Report 140999-01 Page 7
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Report Wizard

Figure 3-26: Report 140999-01 Page 8
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Figure 3-27: Report 140999-01 Page 9
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About RMS Map Manager 3.10

RMS Map Manager 3.10 is a data file viewing, editing, and management tool. Map Man-
ager allows the viewing of all roadside application data collected using a Legacy 6000 
and RMS software. You can can also convert RMS data to the ESRI (.SHP) file format, 
using Map Manager. To start Map Manager, select “Map Manager” from the RMS Office 
Tools Menu (Figure 4-1).

Figure 4-1: Starting Map Manager from RMS Office
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What’s New in RMS Map Manager 3.10

We have added several new features to version 3.10 to help view, edit, analyze, and manage RMS 
data better.

New Explorer File Tree in Map Manager

The Map Manager view now has a fully loaded, explorer style, file tree. This eliminates the old root 
directory method used in previous versions. The file tree allows for full file control, including new 
file, delete, copy, cut, paste, and rename. 

Files or folders can be dragged to a different location in the file tree. If the item is dragged to a dif-
ferent drive, a copy of the item is made; if the same drive, the item is moved. Drag files to the view 
window to open them in a text editor.

Valid layer types now have check boxes. Checking the box opens the layer. Un-checking a box 
removes the layer from the map-view. 

New Shp File Import and Export Functions

Greatly improved from previous versions of Map Manager, the new File Convert routine allows 
batch processing of shape file imports and exports. RMS objects can be in separate shp files or 
multiple object types can be stored in a single (.SHP) file.

Drawing Tools

RMS Map manager now has point, polyline, and polygon drawing tools. You can now add drawing 
objects to (.GMF) files. Drawing tools also include a Circle tool. All drawing objects have full edit 
capabilities.

Text Tool

A new text tool allows you to add text to any (.GMF). Creating a new (.GMF) layer over a roadside 
(.EVP) or (.RCD) file, allows for post session annotation.
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RMS Data and Map Types

The following data files can be viewed in Map Manager:

Data Type Description

GMF General Mapping File.

RCD Record file containing vehicle trajectory and application rates.

EVP Event file

SHP ESRI shape file

ARM Prescription map file (not implemented yet).

Table 4-1: RMS Data Type Description
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Viewing Data

The current version of Map Manager can view any combination of RMS file types, as well as zoom, 
pan, and print. Figure 4-2 shows a roadside trajectory in the form of a (.EVP) file, and a spray cam-
paign map in the form of a (.GMF) file, in a single Map Manager view. The left side of the Map 
Manager window is the directory and file tree, and the right side is the data viewing window. Data 
files are loaded into the view window by double clicking on the file in the directory and file tree. You 
can view files from different spray sessions within the same view window. Each map file, loaded 
into the view page, is considered a single layer.

Figure 4-2: Map Manager
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Base Maps

Background base maps, such as USGS topography maps, can be viewed in Geo-Tif formats. Base 
maps are typically stored in the C:/RMS/basemaps folder. Figure 4-3 shows a base map behind 
the (.EVP) and (.GMF) files shown in Figure 4-2.

Figure 4-3: Viewing Base Maps
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Object Information Query

It is now possible to query any type of data that appears in Map Manager. Using the pointer tool, 
click on the area of the view that contains the desired information. The area selected changes to a 
fluorescent green color, and an Object information dialog box appears on the left side of the Map 
Manager window. The object information dialog box displays a variety of information about the 
object selected, such as position and name. Figure 4-4 shows an information query on an Event 
(.EVP) map hazard, named Spray Off. Figure 4-5 shows a close up of the Object Information dia-
log box for the Spray Off note query. If multiple objects are stacked on top of each other, view infor-
mation, for each object selected, by clicking on the arrow in the Objects Found dialog and 
selecting the object number of the information desired.

 

Figure 4-4: Object Information Query Feature

Object Selected
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Figure 4-5: Object Information Dialog



RMS Office
Software Version 3.10 

Chapter 4 - RMS Map Manager       4-9 
The RMS Map Manager Tool Bar

The RMS Map Manager Tool Bar

The tool bar allows the manipulation of how you view the data in the window. Drawing tools are 
accessed from the Tool bar, as well as zoom, pan, and measure. You can add, remove, and unload 
layers from the view. The current or active layer is the layer that sits on top of all other layers. To 
remove or unload a layer, make it the current layer and click on the remove current layer button. 
Only the current layer can be removed. 

All Map Manager Tool Bar buttons are described in Table 4-2.

Figure 4-6: The Map Manager Tool Bar

Button Description

New File (Layer) - creates a new file (layer) and places it at the current (top) layer in the 
map view. A prompt asks for the new file name.

Open Existing File (Layer) - An Open File dialog allows the selection of an existing file 
(Layer), in the top layer of the map view.

Save File (Layer) - save the current (top) layer in the map view.

Save All - save all files (layers) displayed in the map view.

Print - prints the current map view, with all visible layers.

Table 4-2: Map Manager Tool Bar Button Descriptions

New File (Layer) Open Existing File Remove Current Layer Layers On/Off

Current (top) Layer File Saving Zoom to Extents
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Remove Layer - press to remove (not delete) current (top) layer from the view. This does 
not delete the file.

Layers On/Off - press to bring up the layers On/Off dialog box. Turn layers on and off 
from this dialog box.

Zoom to Current Layer - zooms to the data extents of the current (top) layer.

Zoom to Extent - zooms to the data extents of all visible layers.

Undo Zoom - returns to the previous zoom state.

Selection Arrow - activates the selection arrow (pointer).

Zoom In - enlarges (magnifies) the map view. There are two modes: drag box, and point 
and click.

Zoom Out - increase area displayed in the map view. There are two modes: drag box, 
and point and click.

Pan - select this button, place the hand in the map view, and hold down left mouse but-
ton. Moving the hand with left mouse button depressed moves the contents of the map 
view in a panning fashion.

Point Object - select this button and left click in the map view to place a point object in 
the view. Highlight this object and right click with mouse to edit the object properties.

Hazard Object - select this button and left click in the map view to place a hazard object 
in the view. In real time applications, the user is notified when approaching a hazard. 
Highlight this object, and right click with the mouse, to edit the object properties.

Polyline Object - select and draw a polyline in the map view. Double click the left mouse 
button to stop drawing. This object has two modes: Mark and Stream. Highlight this 
object, and right click with the mouse, to edit the object properties.

Polygon Object - select and draw a polygon object in the map view. Double click the left 
mouse button to close and stop drawing the polygon. This Object has two modes: Mark 
and Stream. Highlight this object, and right click with the mouse, to edit the object prop-
erties.

Button Description

Table 4-2: Map Manager Tool Bar Button Descriptions
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Circle Tool (Drag Option) - select this, to draw a circle by pressing and holding down the 
left mouse button. Drag the mouse with left button depressed to create the desired 
radius. Release the left mouse button to create circle object. Select and hold down the 
left mouse button on the circle tool ,and two other circle drawing options (Radius and 3-
Point) appear in the drop down tool.

Circle Tool (Radius Option) - select, and click the left mouse button at center location of 
desired circle in the map view. A small Radius dialog box appears. Enter the desired cir-
cle radius and click OK.

Circle Tool (3-Point Option) - select, and click left mouse button on three different loca-
tions that the circle perimeter is to intersect. When you select the third point, the circle is 
drawn.

Text Tool - select this to add text to the maps. See The Text Tool on page 4-12.

Guideline Tool - select this to build a guideline file in Map Manager. A - B lines can be 
constructed, either by clicking on the start and end points of the line with the mouse, or 
by entering the coordinates of the start and end points. A (.GLN) file must be the top 
layer.

Measuring Tool - select this to measure the distance between two points. There are two 
modes: mark and stream. Mark mode returns the distance between end points (straight 
lines only), and stream mode returns the length of line distance (curved lines).

Button Description

Table 4-2: Map Manager Tool Bar Button Descriptions
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The Text Tool

The Text Tool allows you to add text to any RMS (.GMF) generated map. To add text, 
select the Text Tool from the Tools menu bar. Left click the mouse, at the location in the 
map, where you want to place the text. The Text Tool dialog appears (Figure 4-7). Type 

the desired text into the Text Tool dialog window. The Text Tool dialog allows the editing of the text 
object properties, such as change font, size, and color. When the desired text is entered, press the 
apply button to view the text in the map view.

Figure 4-7: The Text Tool Dialog
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The File Menu

Almost all tool button functionality can be duplicated in the drop down menus. The File Menu 
allows various file related actions, such as, edit, save, delete, print, convert, and exit Map Man-
ager, be performed (Table 4-3). 

Figure 4-8: The File Menu

Menu Item File Menu Item Description

New New File (Layer) - Creates a new file (layer) and places it at the current (top) layer in the 
map view. A prompt asks for the new file name.

Open Open Existing File (Layer) - An Open File dialog allows the selection of an existing file 
(Layer), which appears as the top layer in the map view.

Save Save File (Layer) - Saves the current (top) layer in the map view.

Save As Saves current (top) layer file with a different file name. A Save As dialog box prompts for 
the new file name.

Save All Save All - Saves all files (layers) displayed in the map view.

Convert Starts the convert application which allows the conversion of RMS data files to ESRI 
shape files, and vise-versa.

Print Prints the current map view, with all visible layers.

Delete Deletes a highlighted file in the file tree. 

Properties Displays the file properties for a highlighted file in the file tree.

Exit Exits the Map Manager Program

Table 4-3: Map Manager File Menu Item Descriptions
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The Layers Menu

The Layers Menu allows the manipulation and querying of information, associated with a map 
layer in the map view window (Table 4-4).

Figure 4-9: The Layers Menu

Menu Item Layer Menu Item Description

Select Current Allows the selection of the current (Top) layer. You can also accomplish this 
from the Tools menu bar (see Table 4-2).

Properties Activates the Layers Properties dialog box.

Remove Current Removes the current layer. You can also accomplish this from the Tools menu 
bar (see Table 4-2).

Remove All Removes all layers from the map view.

On/Off Activates the Layers On/Off dialog box. You can also accomplish this from the 
Tools menu bar (see Table 4-2).

Table 4-4: The Layer Menu Item Descriptions
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The View Menu

The View menu sets up the Map Manager window (Table 4-5).

Figure 4-10: The View Menu

Menu Item View Menu Item Description

Tool Bar Adds or removes the Tool bar in the Map Manager window.

Status Bar Adds or removes the Status bar at the bottom of the Map Manager window, and displays 
the current action, as well as the real world coordinate position of the pointer.

Split Activates the split screen function, allowing the resizing of the map view and file tree.

Zoom to 
Current

Zooms to the current layers data extents. You can also accomplish this from the Tools 
menu bar (see Table 4-2).

Zoom to 
Extent

Zooms to the data extents of all visible layers. You can also accomplish this from the 
Tools menu bar (see Table 4-2).

Zoom 
Previous

Returns to the previous zoom state. You can also accomplish this from the Tools menu 
bar (see Table 4-2).

Show Tags Displays a small yellow tag next to each object in the map view. The tag contains infor-
mation about the object.

Show Scale 
Bar

A map scale dialog appears in the map view (Figure 4-12). 

Show Rates 
Bar

Selecting this, when viewing a (.RCD) file, causes a rates scale dialog to appear in the 
map view (Figure 4-12).

Table 4-5: The View Menu Item Descriptions
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Options Brings up the Options dialog, allowing you to change the system units and coordinate 
system (see Figure 4-11).

Show All 
Files

Allows the file tree to display all file types. When de-selected, the file tree only shows 
RMS file types.

Figure 4-11: The View Options Dialog

Figure 4-12: The Scale and Rates Bars

Menu Item View Menu Item Description

Table 4-5: The View Menu Item Descriptions
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The File Tree Menu

This drop down menu allows you to control which file types are viewed in the file tree (Table 4-7).

Figure 4-13: The File Tree Menu

Menu Item Edit Menu Item Descriptions

Filter On The file tree displays only the files selected in the File Filter.

Modify File Fil-
ter

Allows the selection of the files viewed when the filter is On.

Table 4-6: File Tree Menu Item Descriptions
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The Edit Objects Menu

This drop down menu covers most graphical object editing functions such as cut, copy, and paste 
(Table 4-7). You can also access many of the edit menu items by selecting an object in the map 
view and pressing the right mouse button. 

Figure 4-14: The Edit Objects Menu

Menu Item Edit Menu Item Descriptions

Undo Delete Undeletes a previously deleted object.

Redo Undoes a redo.

Cut Cuts a highlighted object from the view.

Copy Makes a copy of a highlighted object. To place the copy in the view, use paste.

Paste Pastes a copy of an object that has previously been copied or cut.

Delete Deletes a highlighted object.

Edit Activates the Edit dialog box, which allows you to modify object attributes, such as 
object names. Figure 4-15 shows an edit dialog box for a point object.

Properties Displays the Object Information dialog (see Figure 4-5).

Table 4-7: Edit Menu Item Descriptions
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The Tools Menu

Currently the Tools menu has only one tool; Snap. The snap tool has two modes On or Off. When 
set to On, the snap tool snaps any mouse click in the map view to the nearest object. A good use 
of the snap tool is to find the distance between two points.

Figure 4-15: The Edit Box for a Boundary Polygon Object

Figure 4-16: The Tools Menu
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Printing Maps in Map Manager

Version 3.10 of RMS Map Manager brings improved printing capabilities. Pressing the print button 
in the button bar, or selecting print from the file menu, brings up the Print Settings dialog (Figure 4-
17). You can control the look and layout of the printed map from this dialog. Some of the Print Set-
ting features are listed in Table 4-8

Setting Description

Portrait Displays the map in portrait mode.

Landscape Displays the map in landscape mode.

Show Preview Displays a preview of the printed map in the Map Manager Map View. This is 
recommended.

Legend Text Add a Map title and additional text to the printed map. To add text, start typing 
in the Legend text window.

Logo Include a company logo in the printed map. To add a logo, press the browse 
button and select the logo image file.

Scale Bar Include a distance scale bar in the printed map.

Rate Bar Include a Rates legend in the printed map. The map view must contain an 
(.RCD) file.

Target Bar Include a distance Application Target Rate legend in the printed map. The map 
view must contain an (.ARM) file.

Table 4-8: Print Setting Descriptions
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Figure 4-17: The Print Settings Dialog
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Shape File Conversion

Map Manager contains a file option named Convert, which provides a means of transferring data 
between RMS data files and ESRI Shape files. Convert was designed to be both flexible and sim-
ple. It allows beginning users to perform conversions in several simple steps, while offering 
advanced users full control over the data transfer process. The following example illustrates the 
steps required to convert a file. A later example shows how Convert can be used to perform cus-
tom data transfers.

The conversion process is broken into two processes: exporting RMS data files to shape files and 
importing shape files to RMS data files.

Shape files must be in NAD83 or WGS84 Lat/Long coordinates. No other projections or datums 
are supported. ESRI shape files consist of (.shp), (.shx), and (.dbf) files, all sharing the same file 
name.

New Changes to the Shape file Conversion Process

• Batch file and Folder processing.

• Create custom templates.

• Automatically generate an Import template when performing an Export.

• Automatically generate an Export template when performing an Import.

• Select chemical names as an exportable polyline record field. You must create a template to 
suite the particular needs of the conversion. Use these templates when exporting all files into a 
single file.

• Improved error messages

• Select chemical names as a Handgun polyline field.

• Export a new TYPENAME field from all objects. The field names the type of RMS object 
exported. For example, when exporting a point to shape, the TYPENAME field contains Point. 
This new field is useful when merging Points, Arcs, and Polygons or performing “All Files into 
1 file” conversions. The default templates shipped with the product include this field.

• Spray Swaths (Record polylines) includes new UNITS field. This is a string describing the units 
that the ACTUAL and TARGET rate fields are measured in. The default templates shipped 
with the product include this field.

• Export Weather points and Handgun polylines.
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Exporting RMS Data to Shape File Format

This process allows the exporting of any RMS data file type to a shape file(s). Export files one at a 
time or batch export multiple files or folders. The export process comes with several export tem-
plates, which you can edit to best fit individual needs. You can also create new export templates.

The Export to Shape Dialog

Use the Export to Shape dialog to select the file(s) that you want to convert, as well as to start the 
conversion process. Review this dialog prior to converting a file. Table 4-9 describes the various 
features of the Export to Shape dialog box.

Figure 4-18: The Export Dialog
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Function  Descriptions

Export Tree Select the files that you want to export from the Tree view. Tree supports multiple 
selections. Select multiple files with standard explorer style ctrl/left click and shift/
left click.

Include Sub-
directories Check 
Box

When checked, the program exports all files selected and all files found in sub-
directories. The program drills down into any sub-directories within selected directo-
ries, and keeps drilling down until it finds no more sub-directories. When 
unchecked, the program exports all selected files, along with all files in selected 
folders. 

File Filter Type 
Check Box

When checked, only filter type files and directories appear (see set filter). When 
unchecked, all files and directories appear.

Set Filter Select the file types to appear.

Export to Path Type in the export path for the shape files. The Export to Current Location check 
box cannot be checked if an export path is typed in.

Browse Browse for an export location.

Export to Current 
Location Check 
Box

Check to store all exported files in the same location as the original file. This is not 
valid for “All Files Into 1 File” exporting when files from multiple directories are 
selected. Perform an “All Files into 1 File” export for a single job using this check 
box. Uncheck to send all of the exported files to the location specified in the export 
path edit control. 

Convert Starts the conversion process. 

Show Output Shows or hides the output dialog. The shape file conversion progress is displayed 
in the dialog window.

Stop Pauses the export process. A prompt asks whether to continue or abort the export 
process.

Table 4-9: Export to Shape Dialog Description
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The Export to Shape Setup Dialog

In the Setup dialog (Figure 4-19), you can control and set various parameters involved in the 
export process. This dialog should be reviewed prior to exporting any files. The main function of 
the Export Setup dialog is to define which RMS objects are exported, and to describe how these 
objects are transferred/combined to create one or more shapefiles.

Figure 4-19: The Export to Shape Setup Dialog
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Function  Descriptions

2D Radio Button When checked, the program loads all available 2D templates into the template 
combo box. The templates are located in the bin\ template folder.

3D Radio Button When checked, the program loads all available 3D templates into the template 
combo boxe. The templates are located in the bin\ template folder.

Create Import 
Templates

When checked, the program automatically generates an import template for any 
ARC-Polyline, Points-Points, and Polygon-Polygon objects exported. This template 
is a reverse image of the export template used for the object. The new template 
name begins with the word “Import”, followed by the name of the export template. 
For example, if you use the PointToShp.tpl to export points, the import template is 
named Import[PointToShp].tpl.

Merge Points When checked, the program merges all point types, in a given file, into a single 
shape point file. When unchecked, the program exports different point types, in a 
given file, to their own point shape file.

Merge Arcs When checked, the program merges all arc types, in a given file, into a single shape 
arc file. When unchecked, the program merges different arc types, in a given file, to 
their own arc shape file.

Merge Polygons When checked, the program merges all polygon types, in a given file, into a single 
shape polygon file. When unchecked, the program merges different polygon types, 
in a given file, to their own polygon shape file. 

All Files Into 1 When checked, the program merges all exported point shape files into a single 
point shape file, all arc files into a single arc shape file, and all polygon files into a 
single polygon shape file.

File Names This button allows you to select final point, arc, and polygon shape file names for 
“All Files Into 1” File exporting.

Template 
Combo Boxes

Displays all available templates, found in the bin/template folder, that match the 2-D 
or 3-D radio selection. Selecting < Off >, in any of the combo boxes, prevents the 
program from exporting the given type of object to a shapefile.

ARC-Polyline Defines how to convert any polyline in the shape export.

ARC-Record Defines how to represent a swath from a Record (.RCD) in a shape file.

ARC-ITV Defines how to represent an interval in the record file in a shape file. Hand gun is 
now included here.

ARC-Circle Arc Defines how to convert a circle arc in the shape export.

ARC-Handgun Defines how to convert a handgun object in the shape file export.

Points-Points Defines how to convert any point in the shape export.

Points-Weather Defines how to convert any weather point in the shape export.

Table 4-10: Export to Shape Setup Dialog Descriptions
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Polygon-Poly-
gon

Defines how to convert any polygon in the shape export.

Polygon-Circle Defines how to convert any polygon-circle in the shape export.

Polygon-
Circle Pie

Defines how to convert any polygon-circle pie in the shape export.

Function  Descriptions

Table 4-10: Export to Shape Setup Dialog Descriptions
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The Export to Shape Template Dialog

An export template is essentially a set of instructions for transferring the selected object type to a 
Shapefile. The Template Dialog provides a list of available templates for the selected conversion, 
and allows us to manage the templates using the New, Delete, and Edit buttons 

The export template dialog is used when you want to edit an existing template or create a com-
pletely new template. If creating a new template, you must select the new template name in the 
appropriate template combo box, located in the Export Setup dialog. See “Convert Templates” on 
page 4-36 for more information on creating templates.

Figure 4-20: The Export to Shape Template Dialog
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Function  Descriptions

Available 
Templates

Lists all available templates, found in the bin/template directory, that match the 2D 
or 3D radio selection.

2D Radio Button When checked, the program loads all available 2D templates into the template 
combo box. The templates are located in the bin\ template folder. 

3D Radio Button When checked, the program loads all available 3D templates into the template 
combo box. The templates are located in the bin\ template folder.

Edit Button Allows you to edit the current template selection.

Delete Button Allows you to delete the current template selection.

Object Types Lists all available object types that you can create export templates for.

New Button Allows you to create a new template for the current object selection. 

Table 4-11: Export to Shape Template Dialog Descriptions
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Importing Shape Files to RMS Data Files

The second conversion process is importing a shape file into an RMS data file. For example, there 
are many background files such as roadways that are in the shape format. You can import these 
files into a RMS GMF file, and view it in the background of any RMS real-time application, such as 
Mapper.

The Import from Shape Dialog

Use the Import from Shape dialog to select the files or folders that you want to convert from the 
shapefile format to an RMS data file. Review the Import Setup dialog prior to running the Import 
process. Table 4-12 describes the Import from Shape dialog features.

Figure 4-21: The Import Dialog
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Function  Descriptions

Import Tree Select files to import. Tree supports multiple selections. Make multiple selections 
with standard explorer style ctrl/left click and shift/left click.

Include Sub-
directories Check 
Box

When checked, the program imports all files selected and all files found in sub-
directories. The program drills down into any directories within the selected directo-
ries, and keeps drilling down until no more sub-directories are found. When 
unchecked the program imports all files selected, along with all files found in 
selected folders. 

File Filter Type 
Check Box

When checked, only shape files and directories appear (see set filter). When 
unchecked, all files and directories appear.

Import to Path Type in the path to import the shape files to. The Import to Current Location check 
box cannot be checked if you type in an export path.

Browse Browse for an import location.

Import to Current 
Location Check 
Box

When checked, all imported files are stored in the same location as the original file 
used for exporting. If unchecked, the imported files are sent to the location specified 
in the import path edit control.

Convert Starts the conversion process.

Show Output Shows or hides the output dialog. The shape file conversion progress id appears in 
the dialog window.

Stop Pauses the import process. You are asked to continue or abort the import process.

Table 4-12: Import Dialog Description
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The Import Setup Dialog

The Import Setup dialog is where you define what import templates are used for the import pro-
cess. You also select the type of RMS data file, to import data into, in this dialog as well. Table 4-13 
describes the Import Setup dialog features.

Figure 4-22: The Import Setup Dialog
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Function  Descriptions

Create Export Tem-
plates

When checked, the program automatically generates an export template for 
any Point, Polyline, or Polygon objects imported. This template is a reverse 
image of the import template used for the object. The new template name 
begins with the word “Export”, followed by the name of the import template. For 
example, if you use ShpToPoint.tpl to import points, the export template is 
named Export[ShpToPoint].tpl.

2D Radio Button When checked, the program loads all available 2D templates into the template 
combo box. The templates are located in the bin\ template folder.

3D Radio Button When checked the program all available 3D templates into the template combo 
box. The templates are located in the bin\ template folder.

Templates-Point Select the type of import conversion, by choosing a conversion template. This 
template defines how to represent a point, in a shapefile, in an RMS data file.

Templates-Polylines Select the type of import conversion by choosing a conversion template. This 
template defines how to represent an arc, in a shapefile, as a polyline in an 
RMS data file.

Templates-Polygon Select the type of import conversion by choosing a conversion template. This 
template defines how to represent a polygon, in a shapefile, in an RMS data 
file.

Table 4-13: Import Dialog Description
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The Import Template Dialog

The Import Template dialog is used when you want to edit an existing template or create a com-
pletely new template. If you create a new template, the new template name must be selected in 
the appropriate template combo box located in the Import Setup dialog. See “Convert Templates” 
on page 4-36, for more information on templates.

Figure 4-23: The Import Templates Dialog
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Function  Descriptions

Available Tem-
plates Combo 
Box

Displays all available templates in the bin/template directory that match the 2D or 
3D radio selection.

2D Radio Button When checked, the program loads all available 2D templates into the template 
combo box. The templates are located in the bin\ template folder.

3D Radio Button When checked, the program loads all available 3D templates into the template 
combo box. The templates are located in the bin\ template folder.

Edit Button Edit the current template selection.

Delete Button Delete the current template selection.

Object Types Lists all available object types that that you can create import templates for.

New Button Create a new template for the current object selection. 

Table 4-14: Import Template Dialog Description
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Convert Templates

A template contains the information required to convert an RMS file object to a Shapefile object 
(Export), or create an RMS file object from a Shapefile object (Import). To better understand tem-
plates, we must first understand the data that makes up an RMS file or Shapefile object. An object 
(Polygon, Polyline (Arc), Point) is just a shape (one or more positions) with an associated set of 
attributes or fields. The shape's fields specify information about the shape, such as its name or ID. 
RMS file shapes and Shapefile objects are essentially the same. However, the fields associated 
with the shapes are different. To transfer the contents of an RMS file object to, or from, a Shapefile 
object, you must specify how to map or transfer the RMS file object's fields to the Shapefile 
object's fields. The template stores these field transfers. 

Experimenting with the Export or Import dialog shows that different templates are displayed for 
each object type. This is because the fields for each RMS object type are unique. The Export or 
Import dialog only displays templates that make sense for a selected object type. 

You may experience a situation that requires you to create or modify a template. Templates are 
managed using the New, Delete, and Edit buttons, located in the Templates dialog (see Figure 4-
20 and Figure 4-23). To create a new template, press the New button. You are presented with the 
Field Transfer Template dialog (see Setting Up A Field Transfer Template on page 4-37). To delete 
the current template (the template whose name is highlighted in the Available Templates Combo 
Box) press the Delete button. You are presented with a message box that asks you to confirm the 
delete. To delete the template, press the Yes button. Otherwise press No. To edit the current tem-
plate, press the Edit button. You are presented with the Field Transfer Template dialog (see Setting 
Up A Field Transfer Template on page 4-37). 

Figure 4-24: The Field Transfer Template
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Setting Up A Field Transfer Template

Figure 4-24 shows the Field Transfer Template dialog. This dialog is used to set up a field transfer 
template. The Template Name edit box appears at the top of the dialog is. Templates should be 
given a unique name, which identifies the type of conversion they handle. In Figure 4-24, the tem-
plate is named “Point to SHP”, identifying that this template is used for RMS Point object to Shape-
file object conversions.

Below the Template Name edit box is the Field Transfer list. This list contains the field transfers or 
mappings that are performed between the given source file and destination file objects. The 
source file object fields appear in the list's left column and the destination file object fields appear 
in the list's right column. Figure 4-24 shows the mapping of the RMS Point object's NAME field to 
the Shapefile object's NAME field and the RMS Point object's ELEVATION field to the Shapefile 
object's ALTITUDE field.

Use The New, Edit, and Delete buttons, to the right of the Field Transfer List, to change the entries 
in the list. Press the New button to create a new field transfer. You are presented with the Field 
Transfer dialog (see Configuring A Field Transfer on page 4-38). Press the Delete button to delete 
the current field transfer (the transfer currently highlighted in the list). You are presented with a 
message box that asks you to confirm the delete. Press Yes to delete the transfer. Otherwise press 
No. Press the Edit button to edit the current field transfer. You are presented with the Field Trans-
fer dialog (see Configuring A Field Transfer on page 4-38).

Several buttons in the Field Transfer Template dialog only appear when you transfer fields from an 
RMS file to a Shapefile. Use the Up/Down Arrow buttons to change the order of field transfers in 
the list. The order of the transfers determines the order that the program writes the fields to the 
Shapefile in. In Figure 4-24, the SHAPE_NAME field precedes the ALTITUDE field in the resulting 
Shapefile. The Copy All button copies all the fields, in the RMS file object, to the Shapefile object. 
Press this button have your Shapefile object contain an exact copy of the fields in the RMS file 
object. 

Figure 4-25: The Field Transfer Dialog

Unit of Measure Browse 
Button



4-38 Chapter 4 - RMS Map Manager
Shape File Conversion

RMS Office
Software Version 3.10  

Configuring A Field Transfer

Figure 4-25 shows the Field Transfer dialog. Use this dialog to configure a single field transfer. The 
left side of the dialog defines how to transfer a source field to the destination field, shown on the 
right side. Each field setting, on the left, is followed by an arrow button, and a matching field set-
ting, on the right. When the arrow button is active, you can use it to transfer the contents of the left 
setting to the right. Pressing the Copy button, at the bottom of the screen, is equivalent to pressing 
all of the active (not grayed out) arrow buttons.

Use the top pair of settings to define the names of the fields. These settings may take the form of a 
combo box or an edit box. If a combo box is present, you can select one of the names from its list. 
The list contains all the names located in, or compatible with, the field. If an edit box is present, 
type in the name of the field. Figure 4-25 shows ELEVATION selected as the source field's name 
and ALTITUDE selected as the destination field's name. 

The second pair of settings define the field's types. These settings either take the form of a combo 
box or a text box (can't edit). If a combo box is present, you can select the type to associate with 
the field. This affects how the program writes the field to a file, when it performs the conversion. If 
a specific TYPE appears in the box on the left, it is best to chose the same for the box on 
the right. Figure 4-25 shows Double as the destination field's type.

The final pair of settings assign units of measure to the fields. These settings either take the form 
of a combo box or a text box (can't edit). If a combo box is present, you can select the unit of mea-
sure that the program should store the field in. Take care selecting a unit of measure. If the field 
defines a name, or some other non-numeric value, specify <None> for the unit of measure. If you 
don't know the field's unit of measure, select <Unknown>. When the program transfers the field, it 
automatically performs all necessary units of measure conversions. Therefore, it is important that 

Figure 4-26: The Build A Unit Of Measure Dialog
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the source field's and destination field's units of measure are compatible. If the units of measure 
are incompatible, you are presented with an error when you press OK. Figure 4-25 shows meters 
selected as the destination field's unit of measure.

If the Unit Of Measure setting has a Browse button to its right, you can opt to build a unit of mea-
sure for the field. Pressing the button brings up the Build Unit Of Measure dialog (see Figure 4-26). 
This dialog allows you to select or compose a UOM (unit of measure) from a long list of options. If 
you wish to select a UOM from the list, you can type the UOM's name in the “Unit Of Measure” edit 
box, or find the UOM in the list. You can compose new compound UOMs (such as pounds/acre) by 
separating UOMs in the list with a '/'. Pressing the “/ (Per)” button adds the '/' for you. If you make 
a mistake, simply click the Clear button, or erase the text in the “Unit Of Measure” edit box.   When 
you select OK, your UOM is passed to the Unit Of Measure setting.

Under some circumstances, the Field Transfer dialog's appearance undergos some changes. One 
such circumstance arises when we set the source field's name to <CONSTANT> or <COUNTER>. 
<CONSTANT> and <COUNTER> are special, user-defined, fields. They do not exist in the source 
file object.   If you set the source field name to <CONSTANT>, a Value setting replaces the source 
field's Type setting (Figure 4-27). The Value setting is a string or number, passed to the specified 
destination field for each object written to a file. If you set the source field name to <COUNTER>, a 
First Number setting replaces the source field's Type setting. As its name implies, the First Number 
setting represents the counter's starting value. Each time the program transfers the counter value 
to the specified destination field, it increments the value by one. For example, if the First Number is 
set to 2, the specified destination field would receive a 2 for the 1st object, a 3 for the 2nd object, a 
4 for the 3rd object, and so on. 

Templates are a complex, yet powerful, tool. Creating templates takes some practice. However, 
when you get the hang of it, you should be able to perform an almost limitless array of RMS/
Shapefile conversions.

Figure 4-27: User Defined Fields
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